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Kroll Version 10 Service Pack 31 Feature Release Notes 

This document is a compilation of new Features in Kroll Version 10 Service Pack 31. The purpose is to keep 

users informed of changes to the software and to help users implement and adapt to those changes. 

Appointment Calendars 

[KRL-11674] Support the creation and booking of appointments by time units 

Feature 

Kroll has been enhanced to provide greater flexibility and precision in scheduling Calendar Appointments. 

Appointments are now allocated based on the designated time for each Appointment Type, rather than a fixed 

amount of time for each time slot. 

The Create Calendar Appointment Time Slots form, which 

appears when creating new unreserved time slots for online 

appointments, has been updated with a more intuitive layout. 

This form is accessed by selecting the Create Public 

Appointment Slots option from the Utilities > Calendar top 

menu. 

The Appointment Types listed in the Available appointments 

(for online reservation) section now display their default 

duration time in brackets. 

As a user selects one or more Appointment Types from the list, 

the time slots duration (every _ mins) is automatically populated 

with the shortest duration value from the selected Appointment 

Types. 

The time slot creation process remains unchanged. Clicking the 

Create time slots button will create new unreserved time slots 

on the Calendar at the specified intervals. 
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When a patient books an appointment online via a PharmacyLink-supported app, the time allocated for it on the 

Calendar will depend on the Appointment Type. 
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The duration of each booked Calendar Appointment will correspond to the Default Time value set for the 

corresponding Appointment Type in Kroll. 

 

Similarly, when an appointment is booked by a user in Kroll by editing an unreserved time slot on the Calendar, 

upon selecting the Type on the Edit Appointment form, the duration will be automatically populated with the 

corresponding Default Time. 
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If the selected duration causes the appointment to overlap with a subsequent appointment, a red text message 

will appear above the duration drop-down list stating 'Duration overlaps reserved slot’. 

 

When an appointment exceeds the selected unreserved time slot and extends into subsequent unreserved time 

slots, those slots are automatically removed to prevent future bookings from overlapping. 

 

When a booking that exceeds a time slot is either cancelled by the patient online or deleted by a user in Kroll, the 

previously removed unreserved time slots will automatically be restored at the predefined intervals. 
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When a Kroll user attempts to edit an unreserved time slot that is currently being reserved by a patient online, a 

dialog will be displayed. The dialog will prompt the user that continuing with the edit will force the online user to 

choose another time slot. 

 

[KRL-12327] Support customizable Categories for Appointments 

Feature 

Kroll users can now manage Appointment Categories. 

A new tab called Appointment Categories has been added to the Edit Mast Lists / Groups screen. 
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Users can use the Ins button to add a new Appointment Category or the F2 and Del buttons to edit or delete an 

existing one respectively. Additionally, two arrow buttons allow users to adjust the position of a selected 

Category by moving it up or down the list. 

The Edit Appointment Category form, displayed when inserting or deleting a category, allows users to specify 

the Name and Details for the category. 

The Details field allows users to enter additional information regarding the category of service to help their 

patients using PharmacyLink make informed selections. A green circle with a white ‘i’ symbol is displayed next to 

this field. Hovering over the symbol will display a bubble with the Details text. 

The PharmacyLink Category Mapping field contains the configuration string required for the Category to display 

in PharmacyLink-supported online applications. This field is only visible when the PharmacyLink module is active. 

When a configuration string is entered in this field, the Appointment Category is marked as 'Global' and becomes 

managed by the PharmacyLink network. 

 

[KRL-12328] Update Appointment Types screen 

Feature 

The Edit Appointment Type form, displayed when editing or inserting an Appointment Type, has been updated 

with new settings to support an enhanced online appointment booking experience. 
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• The Category drop-down list enables users to select an Appointment Category. Categories are listed 

according to the sorted order in the Appointment Categories tab. If the selected Category has additional 

details, a green circle with a white ‘i’ symbol will appear next to this field. Hovering over the symbol will 

display a bubble with the Category Details text. When the selected Category is correctly mapped to a 

PharmacyLink category, the Appointment Type will be listed under the same Category in PharmacyLink-

supported online applications. 

• The Details field allows users to enter additional information regarding the service provided to share with their 

PharmacyLink patients. A green circle with a white ‘i’ symbol is displayed next to this field. Hovering over the 

symbol will display a bubble with the Details text. 

• The Methods section lets users specify if the appointment is for a service provided In Person, by Phone, 

and/or Virtually. 

 

The Name, Category, and Methods fields are mandatory. A message will prevent saving an Appointment Type 

without specifying a value for all of these fields. 
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[KRL-12553] Update the Edit Appointment screen to support changes to Appointment Types 

Feature 

The New Appointment and Edit Appointment forms, displayed when creating or editing Calendar 

Appointments, have been updated to restrict the options available in the Method drop-down list to only those 

enabled for the selected Appointment Type. If no Appointment Type is selected in the Type field, all applicable 

methods are displayed. 

NOTE: The Virtual method will only be available when an active PharmacyLink network is selected in the Send 

appointment notifications using PharmacyLink network setting, located in the Interface tab of the Store Level 

Configuration Parameters screen. 
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If a Calendar Appointment is saved with a specific Type and Method, and the selected Appointment Type is 

later modified to disable the Method that was originally selected, the Calendar Appointment will still retain the 

original Method selection. 

[KRL-12595] Update Appointment Categories and Appointment Types to support legacy lists 

Feature 

To support backward compatibility and ensure a seamless update to Kroll Version 10 Service Pack 31, a default 

list of Appointment Categories has been created. This list reflects the legacy hardcoded Categories already 

used for Appointment Types. The Appointment Types will automatically be linked to the Categories that match 

the pre-existing service set. 

 

When upgrading to Service Pack 31, if a store is currently linked to a PharmacyLink network, the Appointment 

Categories will also have the PharmacyLink Category Mapping populated, making them 'global'. However, if a 

store is not linked to a network at the time of upgrading or is a new install of Kroll, the Appointment Categories 

will not be populated with global mappings. In such cases, the mappings will need to be done manually later when 

the store is added to a network. 



Kroll V10 SP31 Feature Release Notes  13 

[KRL-13207] Block users from adjusting the Category Name and Details if the Category is ‘Global’ 

Feature 

When a configuration string is entered in the PharmacyLink Category Mapping field in the Edit Appointment 

Category form, the Appointment Category is marked as 'Global' and becomes managed by the PharmacyLink 

network. When a Category is marked as ‘Global’, regular Kroll Users are unable to edit any field in the form, 

including the Name and Details. To allow regular Kroll Users to edit these fields, any value in the PharmacyLink 

Category Mapping field must be removed first. 

The PharmacyLink Category Mapping field can only be edited by Head Office Users when managed via Kroll 

Central Maintenance (KCM), and by Kroll Super Users if not managed by Head Office via KCM. Regular Kroll 

Users can never edit this field, and it appears grayed out to them. 

 

Auto Refill 

[KRL-11538] Update database to capture the patient's Refill Type preference 

Feature 

The Refill Type drop-down list in the Communication Methods tab of the patient Outbound Communication 

screen has been updated with a new selection option: 

• Auto refill 
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This new option consolidates and replaces the previous ‘Auto Fill Pickup’ and ‘Auto Fill Delivery’ options. 

Setting the patient Refill Type to the new 'Auto Refill' option will trigger the display of the Auto Refill option in the 

Plans tab of the F12 prescription-filling screen, similar to how it previously worked with either of the former 

options. 

 

In prior versions, when the ‘Auto Fill Pickup’ option was selected, and a prescription was filled with the Auto 

Refill option enabled, the ToDo record created would have the Delivery Route set to ‘Pickup’. On the other hand, 

filling a prescription for a patient set to ‘Auto Fill Delivery’, would generate a ToDo record with a ‘Store Delivery’ 

Delivery Route. 

With the new change, the Delivery Route of the ToDo record created when filling a prescription with the Auto 

Refill option enabled will instead be dictated by the Delivery Type specified in the General tab of the Patient 

card. 
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[KRL-11539] Create new prescription-level fields to store the prescription’s Refill Type preference 

Feature 

Kroll has been enhanced with a new function that enables users to set the Refill Type preference for each 

prescription individually. This enhancement allows users to set the Refill Type of a specific prescription to a value 

different from the patient’s default preference. 

In previous versions, the Refill Type preference specified in the patient Outbound Communication screen 

determined which option would appear in the Plans tab of the F12 prescription-filling screen. The option in the 

Plans tab could only be enabled or disabled. 

Now, the patient’s Refill Type preference will determine the option displayed by default in the Plans tab of the 

F12 screen when filling a prescription. However, when the option is enabled, the field will become a drop-down list 

that displays the other Refill Type options available for that prescription. 

 



Kroll V10 SP31 Feature Release Notes  16 

The availability of these options depends on the drug being filled, subject to the Refill/Renewal Reminders 

Allowed setting in the Other tab of the F5 - Drug screen. The options selectable at the prescription level include: 

• Default - This option reflects the Refill Type preference specified in the patient’s Outbound 

Communication screen. 

• Auto Refill - A To-Do item will be created and added to the Rxs To Do list in the F9 - Workflow screen, with 

a specific Due date. A notification can be sent to the patient to notify them that their prescription will soon be 

refilled. 

• Confirm Before Fill - A notification will be sent to the patient on a specific date, prompting them that their 

prescription is due to be refilled. 

• None - No action is taken. 

[KRL-11541] Update the ‘Copy to New’ functionality to retain prescriptions Refill Type preference 

Feature 

When copying a prescription to a new number, the Refill Type value from the original prescription will be inherited 

by the newly created prescription. 

[KRL-11805] Add setting to Store Level Configuration Parameters to control Auto Refill Reminder 

notifications 

Feature 

A new setting has been introduced in the Store Level Configuration Parameters screen, located in the 10 - 

Auto-Refill/Reminders sub-tab within the Rx tab. 

• Create Auto Refill reminders _ days before Auto Refill date 

This setting allows users to specify the number of days before the Auto Refill date that an Auto Refill 

Reminder notification will be sent to the patient. If this setting is left blank, no notifications will be sent. 
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[KRL-11845] Add Auto Refill and Auto Refill Reminder date fields to the F12 prescription-filling 

screen 

Feature 

When a prescription's Refill Type is set to ‘Auto Refill’, two related date fields will be displayed in the Dates tab 

within the F12 prescription-filling screen: 

• Auto Refill date: This field indicates the date the prescription will be due for refill and determines the Due 

date of the To-Do item added to the Rxs To Do list in the F9 - Workflow screen. 

• Auto Refill Reminder date: This field indicates the date when a notification will be sent to the patient, where 

permitted, informing them that a prescription will soon be refilled automatically. 
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[KRL-11864] Automatically calculate Auto Refill and Auto Refill Reminder dates 

Feature 

The prescription’s Auto Refill and Auto Refill Reminder dates will be automatically calculated and pre-populated 

when filling a new prescription or refilling or modifying an existing prescription, provided the prescription’s Refill 

Type is set to ‘Auto Refill’. 

• Auto Refill date: This field existed in previous service packs, and its function and logic remain unchanged. 

The pre-populated date is calculated based on the prescription’s Fill date, Days of supply and related 

settings in the Store Level Configuration Parameters. 

• Auto Refill Reminder date: This new field has been introduced with this service pack. It indicates the date 

when a notification will be sent to the patient, where permitted, informing them that a prescription will soon be 

refilled automatically. The pre-populated date is calculated by subtracting the number of days specified in 

the Store Level Configuration Parameters setting ‘Create Auto Refill reminders _ days before Auto Refill 

date’ from the prescription’s Auto Refill date. 

Users have the ability to override any of these dates by manually entering a new date. 
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[KRL-11866] Validate that the prescription Auto Refill Reminder date is not after the Auto Refill 

date 

Feature 

To ensure data consistency, the system will validate that the Auto Refill Reminder date is not set after the Auto 

Refill date whenever a user manually changes either of these dates. 

If the Auto Refill Reminder date is set after the Auto Refill date, a hard-stop message stating "Auto Refill 

Reminder date cannot be after Auto Refill date" is displayed in the warning section, preventing the user from 

filling the prescription. 

 

[KRL-12127] Trigger Auto Refill Reminder notification 

Feature 

On the Auto Refill Reminder date, the system will send a notification to the patient, informing them that their 

prescriptions will soon be automatically refilled. This notification will only be sent if the patient has opted to receive 

refill notifications. 
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[KRL-12363] Create To-Do items when changing the patient's preference to Auto Refill 

Feature 

Kroll has been enhanced with a new function that will create To-Do records for eligible prescriptions when the 

patient’s Refill Type preference is changed to ‘Auto Refill’ after they have been filled. 

When a prescription’s Refill Type is set to ‘Default’ and the patient’s Refill Type preference is initially set to a 

value other than ‘Auto Refill’, no To-Do record is created for that prescription at the time of filling. This is because 

the ‘Default’ option mirrors the Refill Type preference selected in the patient’s Outbound Communication 

screen. 

With the new enhancement, if the patient’s Refill Type is changed to ‘Auto Refill’ at a later time, a To-Do item 

will be created and added to the Rxs To Do list in the F9 - Workflow screen for each of these prescriptions. 

[KRL-12364] Delete To-Do items when changing the patient's preference from Auto Refill 

Feature 

Kroll has been enhanced with a new function that will delete To-Do records for applicable prescriptions when the 

patient’s Refill Type preference is changed from ‘Auto Refill’ to a different value. 

When a prescription’s Refill Type is set to ‘Default’ and the patient’s Refill Type preference is initially set to 

‘Auto Refill’, a To-Do record is created for that prescription. This To-Do item is added to the Rxs To Do list in the 

F9 - Workflow screen. 

With the new enhancement, if the patient’s Refill Type preference is later changed from ‘Auto Refill’ to a 

different value, the corresponding To-Do items will be automatically deleted from the Rxs To Do list in the F9 - 

Workflow screen for each applicable prescription, ensuring the workflow is kept up-to-date with the patient's 

current preferences. 

[KRL-12565] Update Patient, Drug and Prescription options 

Feature 

The Refill Type drop-down list in the patient’s Outbound Communication screen has been updated to display 

four options:  

• Disabled 

• Confirm Before Fill 

• Auto Refill 

• Default Off 
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• Disabled: This option disables the Auto Refill and Refill Reminder functions for the patient. Users are 

prevented from enabling these functions at the prescription level.  

• Confirm Before Fill: Setting the patient’s Refill Type to this option will trigger the Refill Reminder and 

Enable Renewal Reminder options to show in the Plans tab of the F12 screen. 

 

Enabling the Refill Reminder option will show a drop-down list that allows users to select a different option 

specifically for that prescription. The Default option will be set to ‘Confirm Before Fill’. 



Kroll V10 SP31 Feature Release Notes  22 

 

• Auto Refill: Selecting this option will trigger the Auto Refill option to appear in the Plans tab of the F12 

screen. 

 

Enabling the Auto Refill option will show a drop-down list that allows users to select a different option 

specifically for that prescription. The Default option will be set to ‘Auto Refill’. 
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• Default Off: Setting the patient preference to ‘Default Off’ will trigger the appearance of an option labelled 

‘None (Default)’ on the Plans tab of the F12 screen. 

 

This indicates that both the Auto Refill or Refill Reminder functions are disabled for the prescription, 

however, enabling this option will trigger the appearance of a drop-down list from which users can select a 

Refill Type applicable to that prescription. 



Kroll V10 SP31 Feature Release Notes  24 

 

The Refill/Renewal Reminders Allowed drop-down list located in the Other tab of the F5 - Drug screen has 

been updated to display new options. 
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• No Refill Reminders and Allow Auto Refill 

• Refill Reminders and Allow Auto Refill 

• Refill and Renewal Reminders, Auto Refill On 

• No Refill Reminders or Auto Refills 

The Refill Type options in the Plans tab of the F12 prescription-filling screen have been updated to include the 

‘None’ option. 

 

• Default - This option reflects the Refill Type preference in the patient’s Outbound Communication screen. 

• Auto Refill - A To-Do item will be created and added to the Rxs To Do list in the F9 - Workflow screen, with 

a specific Due date. A notification can be sent to the patient to notify them that their prescription will soon be 

refilled. 

• Confirm Before Fill - A notification will be sent to the patient on a specific date, prompting them that their 

prescription is due to be refilled. 

• None - No action is taken. 

[KRL-12569] Display prescription preferences and default value based on drug preferences and 

patient Refill Type preferences selection 

Feature 

The options selected in the Refill/Renewal Reminders Allowed drop-down list located in the Other tab of the F5 

- Drug screen have been updated to display new options. 

These settings will take precedence over the patient's settings in determining which options are available in the 

Plans tab at the prescription level. What options are effectively displayed at the prescription level are calculated 

according to the preferences on both the Drug and the Patient cards. 

• No Refill Reminders and Allow Auto Refill: This option does not allow the Refill Reminder option but allows 

the Auto Refill and None options. 
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• Refill Reminders and Allow Auto Refill: This option allows the Refill Reminder, Auto Refill and None 

options. 

• Refill and Renewal Reminders, Auto Refill On: This option allows the Refill Reminder, Auto Refill and None 

options. 

• No Refill Reminders or Auto Refills: When this option is selected, neither the Refill Reminder nor the Auto 

Refill option is allowed. 

Counselling 

[KRL-11933] Provide users with the ability to enable or disable Order prescription Counselling 

Feature 

PharmacyLink-supported applications offer patients the ability to request Counselling for any prescriptions in 

their online orders. 

A new setting has been introduced in Kroll to control the availability of this option. This setting is located in the 

Store Level Configuration Parameters screen, within the PharmacyLink section of the Interfaces tab: 

• Allow Order Rx Counseling 

When enabled, patients using online applications can request counselling for the prescriptions in their order. 

When disabled, they will not be provided with the option to request counselling in the online application. 

This new setting gives pharmacies greater flexibility in managing patient interactions and ensuring that 

counselling is available when appropriate. 
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Drug Ordering 

[KRL-11821] Cleanup of unused Ordering/Receiving Units  

Improvement 

The Drug Ordering functionality has been streamlined to enhance performance and reduce complexity. As part 

of this improvement, several outdated Vendors have been removed, along with any logic or references to them in 

the code. This cleanup makes the Drug Ordering feature more efficient and easier to maintain. 
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ERx 

[KRL-11689] Update the ERx queue, New Rx ToDo and External Rx Order screens to indicate 

modifications to a PointClickCare prescription 

Feature 

The ERx queue of the F9 -Workflow screen has been enhanced to better display PointClickCare (PCC) 

prescription orders. The New Rx ToDo and External Rx Order screens have also been updated to provide users 

with a more streamlined experience. 

When receiving prescription orders from PCC, New prescription orders will always be displayed in the ERx 

queue. However, any associated Modify order received from PCC will be displayed only if the original New order 

has already been processed. 

 

• When a Modify order is received for an unprocessed New prescription order (still in the ERx queue), the 

system will keep the original New prescription entry in the queue and the Modify request will not be displayed. 

Instead, it will be pended in the background, associated with the New Prescription request. Any subsequent 
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Modify orders will be similarly pended. The Modify orders will be displayed and applied when the New 

prescription order is processed. 

• If a Modify order is received for a New prescription order that has been processed but not yet completed, 

the Modify order will be displayed in the ERx queue as a separate record for triage after the New prescription 

order is completed. 

• When receiving Modify orders associated with a completed New prescription order, only the most recent 

Modify request received will be displayed, while all unprocessed Modify orders will be pended in the 

background against the original New prescription order in chronological order. 

When processing a New prescription order, the New Rx ToDo screen is displayed and the system will check for 

one or more pending Modify requests associated with the New prescription order being processed. If no 

associated Modify requests exist, the system will process the New prescription order as usual, displaying details 

from the New prescription order request. If there are one or multiple associated Modify orders, the system will use 

details from the most recent Modify order received. The right-hand side of the screen will display the latest 

information, as this will have the most current details. 

Once the New prescription order is completed and a new prescription has been created, Kroll will remove the 

New prescription order from the queue and mark it as ‘Completed’, ensuring all associated Modify orders are 

also marked as ‘Completed’. 

The system will prompt the user when they attempt to select a Suspend, Resume, or Discontinue order if a 

previous New prescription or Modify order associated with it is still in the ERx queue. If the user selects 'Yes' to 

the prompt, the system will check the Order ID and look for the oldest associated order in the ERx queue, 

prompting the user to select that order. Selecting a New prescription order associated with a Modify order will 

then process that order plus the Modify orders at the same time. 

 

When attempting to process an order that has no New prescription order associated with it, the system will 

prompt the user that no order exists. 
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The New Rx ToDo screen, displayed when processing a New prescription order, has been updated to support 

the above changes, including the association with pending Modify requests. 

The previous General tab has been replaced by a new tab for every additional order linked to the original New 

prescription order. Each tab is labelled with the relevant order type: New, Modify, Suspend, Resume, 

Discontinue. For multiple orders of the same type, a number is added to the label name (e.g., Modify 1, Modify 2, 

etc.). These tabs appear in the sequence in which the orders were received from PCC. 

 

 

Users can select any tab to view the information received with each corresponding order. The tab for the most 

recent Modify order received from PCC is displayed by default and features a green check mark symbol on 

its label. The panel on the right-hand side of the screen, displaying the new prescription data, will be pre-

populated based on the final Modify request, and users can edit information on this panel. 
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Two read-only fields, Suspend Date and Resume Date, will be displayed and populated only for Suspend or 

Resume order types, respectively. 

Two buttons have been added to the Order Info section: View Changes and View Details. 

 

The View Changes button is available on each Modify tab. Pressing this button opens the ERxOrder Changes 

screen, displaying the data differences between the selected Modify order and the most recent one. If the first 

Modify order in chronological order is selected, the ERxOrder Changes screen will display the changes against 

the original New prescription order. 

 

The View Details button is available on any tab. Pressing this button will display the ERx Order Details screen, 

showing the order data received from PCC. 
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The External Rx Order screen, accessible by selecting the External Rx Order option from the View top menu in 

the F12 prescription-filling screen, has also been updated to support the above changes. 

Tabs have been added to the screen with a new tab for every additional order linked to the original New 

prescription order. Each tab is labelled with the relevant order type: New, Modify, Suspend, Resume, 

Discontinue. For multiple orders of the same type, a number is added to the label name (e.g., Modify 1, Modify 2, 

etc.). These tabs appear in the sequence in which the orders were received from PCC. If the order originated in 

Kroll, then there will be no ‘New’ tab to display. 

When the External Rx Order screen is opened, the system automatically defaults to the tab relevant to the action 

the user is performing. For example, if the user is processing a Modify order with pending Modify orders, then the 

most recent Modify order tab will be displayed by default. 

The View Changes and View Details buttons have been added to the Order Info section, functioning the same 

as they do in the New Rx ToDo screen. 
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Additionally, the option Use this sig code in the Rx now works for each Modify tab. Checking this option will 

update the prescription with the SIG from the Modify order. 

 

[KRL-11690] Improved Suspend Rx and Resume Rx screens for PointClickCare 

Feature 

Kroll has been enhanced with a new feature that facilitates pharmacy users triaging Suspend and Resume 

prescription requests from PointClickCare (PCC). 

When orders to Suspend or Resume prescriptions are received from a PCC facility, they are displayed in the ERx 

queue in the F9 - Workflow screen. Users can process these requests from the ERx Items screen to update the 

associated prescriptions. 

Previously, these requests were managed through a floating window with little reference to the patient record. 

These screens have now been updated to display an embedded screen in the Kroll window, including both a top 

menu and a side-bar ribbon menu, as well as a yellow section at the top displaying patient information. 

• Suspend Rx screen 

• Resume Rx screen 
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The top portion of the screen features a yellow section displaying the patient’s information. 

The Suspend Rx and Resume Rx screens now feature two additional top menu options: View and Profile. 

View menu options: 

• External Rx Order: Opens the newly updated External Rx Order screen, defaulting to the tab relevant to the 

action the user is performing. 

• Nursing Home Info (hotkey: Alt+N): Opens the prescription’s NH Rx Information screen. 

Profile menu options: 

• All Rxs (hotkey: Shift+F3) 

• All Rxs (hotkey: Shift+F4) 

• Active Rxs (hotkey: Shift+F5) 

• Refillable Rxs (hotkey: Shift+F6) 

• Pricing Profile (hotkey: Shift+F7) 

• Not Disp/OTC Profile (hotkey: Shift+F8) 

• Rxs Filled in Error (hotkey: Shift+F9) 

• Active Rxs and Passtimes (hotkey: Shift+F10) 

• Suspended Rxs 

• Transactions (hotkey: Shift+F2) 

• Perform Clinical Analysis (hotkey: Alt+N) 

These options are the same as those found in the F3 - Patient card and will display in a new window when 

selected.  

The ribbon bar on the right-hand side features two sections: View and Profile. The options under each section 

mirror the respective top menu options. Situated between these sections is an additional option: 

• Print Electronic Hard Copy: When selected, the button turns green. Completing the order will automatically 

print out the order’s Electronic Hardcopy. 

Moreover, the F3 - Patient button is available when in the Suspend Rx or Resume Rx screens. Selecting this 

button displays the F3 - Patient card. When on the Patient card, a Return button with a green check mark is 

displayed at the top right of the card. Pressing the button navigates the user back to the Suspend Rx or Resume 

Rx screens. 
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[KRL-11695] Support patient Middle Name for ADT/ERx queues and incoming orders 

Feature 

The ADT and ERx queues have been updated to support patients' Middle Names. The patient name column on 

both the ERx Items and ADT Items screens now includes the Middle Name. The Middle Name is appended to 

the First Name, separated by a space, resulting in the format: Last Name, First Name Middle Name (e.g., Smith, 

John Mark). 

 

The Pat filter has also been updated to display the patient's Middle Name. 
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The ADT Wizard screen, which is displayed when processing an item from the ADT Items screen, has been 

updated to include the Middle Name field in both the Incoming ADT Patient and Selected Patient sections. This 

update ensures that the patient card is accurately updated if a request is received from an Electronic Medical 

Records (EMR) service. 

 

Furthermore, the following ERx Order-related screens now include the patient’s Middle Name: 
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ERx Order Details screen 

 

External Rx Order screen 
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New Rx ToDo screen 

 

Additionally, the Electronic Hardcopy that can be printed from these screens will also include the middle name: 
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[KRL-11887] Mark subsequent PointClickCare Modify/Suspend/Resume/Discontinue orders as ‘in 

Progress' if a New prescription order is unprocessed 

Feature 

Kroll has enhanced the management of scenarios where a New prescription order received from PointClickCare 

(PCC) is still in the ERx queue awaiting processing, and the nursing home facility sends subsequent orders 

associated with that original order. 

If the user selects Reject Item or Mark as Processed for the New prescription order, any subsequent orders 

received for that new request will be automatically removed from the ERx queue. When rejecting the New 

prescription order, a rejection message will be sent for the order itself, but no reject messages will be sent to PCC 

for the subsequent orders. 

Previously, users were required to manually mark all subsequent Modify, Suspend, Resume, and Discontinue 

orders as ‘Rejected’ or ‘Processed’ to remove them from the ERx queue. 

General 

[KRL-12044] Modifications to the window displayed when cancelling a prescription 

Feature 

The Confirm Rx window displayed when cancelling a prescription has been modified for improved clarity. All 

functionalities remain unchanged, but the following cosmetic updates have been made: 

• The title of the window has been renamed to ‘Confirm Cancellation’. 

• The three buttons have been updated: 

• The Yes button has been renamed to ‘Cancel’. Clicking this button will proceed to cancel the prescription. 

• The No button has been renamed to ‘Go Back’. Clicking this button will abort the cancellation and return the 

user to the previous screen. 

• The Cancel and Refill button has been moved to the middle. 
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Minor Ailments 

[KRL-10172] Support filling Mixture prescriptions when included in a Minor Ailment assessment 

(British Columbia) 

Feature 

The Minor Ailment module in Kroll has been enhanced to support the prescribing of Mixtures to treat minor 

ailments. This feature is currently only available in British Columbia. 

In configurations where the Minor Ailment module is enabled, users can perform assessments for Minor Ailments. 

This module leverages the Vigilance Santé RxConsultAction web engine to process the information entered by 

the user. It also allows users to automatically generate a prescription based on the data provided in the 

RxConsultAction screen during the assessment. 

The RxConsultAction form now supports prescribing mixtures to treat minor ailments. A new option within the 

Prescribe section of the form allows users to choose between Medication and Compounding Formula. 

Selecting the latter enables users to specify the Name, Strength, and Form of the mixture, as well as the 

Quantities, Duration, and Sig for the prescription. 
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Kroll has been updated to support this feature. When a user performing the assessment selects to prescribe a 

mixture and then selects Conclude Intervention to finalize the Minor Ailment assessment, the mixture data 

entered in the Prescribe section will be automatically utilized by Kroll to create a mixture prescription or To-Do 

record. 

If no exact match is found for the mixture, Kroll will automatically populate the F5 - Mixture search screen with the 

name from the RxConsultAction module. 

 

Once a mixture is selected, the user is taken to the F12 - Fill Rx screen, where the prescription data is 

prepopulated with values from the RxConsultAction module. 
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Patient 

[KRL-12123] Modifications to the F3 - Patient Card 

Feature 

To enhance patient care and safety, the F3 - Patient card in Kroll has undergone significant updates. These 

changes aim to improve usability and provide more comprehensive patient information. 

• The patient name fields have been consolidated into one field which is now read-only. Users can modify the 

name via a new Modify button, which opens the Patient Name window for editing.  

• The Alt. Last Name field has been removed from the General tab and has been included in the Patient 

Name window. 

• The Family Doctor field has been relocated and labelled as ‘Family Dr’, positioned under the Quick Code 

field for better organization. 

• The Comments section has been resized to match the height of the Plans section, with the addition of a 

scrollbar for improved navigation. 
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• Height and Weight fields have been repositioned under the Phone Numbers section. 

• The previous Gender field has been renamed to ‘Sex’. A new Gender field, however, has been introduced. 

The values for this field are configured in the Master Lists accessed via Edit > Lists. 

• The Language field has been repositioned next to the Sex field. 

• A new Pronouns field has been added, also populated from a master list accessed via Edit > Lists. 

 

[KRL-12240] Enhanced Patient Name form to include Middle Name, Suffix, Preferred First Name 

and Alternate Last Name 

Feature 

Changes have been made to enhance the way users can modify a patient's name from the patient card while 

maintaining high usability. The patient name fields have been consolidated into a single read-only field at the 

top of the patient card. Users can modify the names via a new Modify button, which opens the Patient Name 

window for editing. 
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• When the window opens, the cursor focus is set on the Last 

Name field for quick action. 

• Users can navigate through the fields using the Tab key, 

moving from top to bottom, or using the hotkey (Ctrl + 

underlined letter) to select a specific field. 

• New fields are available: Middle Name, Suffix, and 

Preferred First Name. 

• Fields are ordered in a meaningful way, with the most popular 

fields placed at the top for convenience. 

• The values displayed in the Salutation and Suffix fields are 

configured in the Master Lists accessed via Edit > Lists. 

• Only the First Name and Last Name fields are mandatory. 

• To save the changes, users can press the Enter key or click 

OK. However, the Patient record is updated only after clicking 

Save on the patient card. A visual cue indicates that a 

change has been made on the patient card, maintaining the 

same behaviour as before. If the First Name or Last Name 

has been altered, a confirmation dialog will appear, allowing 

users to compare the new values against the original ones. 

• Clicking on Cancel exits the window without saving any changes. 

[KRL-12250] Added new Gender, Pronouns, and Suffix Master Lists 

Feature 

The Gender, Pronouns, and Suffix fields have been introduced to the Patient card and are now displayed and 

utilized in various parts of the application, including Workflow queues and the ADT Wizard module. 

It is important to note that pronouns and gender information are not exposed to the patient or any third party. This 

information is only available to the Kroll user and is intended to enhance patient care. Reports, labels, and other 

outputs do not include this information. 

As these new fields rely on a list of predefined values, three new Master Lists have been created to support 

them: 
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• Gender 

• Pronouns 

• Suffix 

Master Lists can be accessed by selecting the appropriate list from the Lists drop-down menu in the Master List 

view of the Edit Master List / Groups screen. This screen is accessible via the Lists option in the Edit top menu. 

The new Master Lists are pre-populated with a standard set of values, which cannot be modified. However, 

users have the flexibility to Insert, Modify, or Delete any custom values from the Master Lists and reorder the 

lists as needed. Stores that are centrally managed via Kroll Central Management (KCM) can request new values 

to be added centrally. 
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[KRL-12251] Modifications to the Patient record insertion process 

Feature 

Kroll users are required to search for a patient record before they can insert a new patient in the F3 - Patient 

screen.  

When inserting a new patient, the newly introduced Patient Name form will be displayed. This form’s Last Name 

field will be pre-populated with the value entered in the search field during the search process. If the user 

entered two comma-separated values in the search field, the Last Name and First Name fields will be populated 

using the “Last Name, First Name” schema. 

 

[KRL-12252] Enhanced Patient Search functionality to include Preferred First Name, Middle Name 

and Alternate Last Name 

Feature 

Changes have been made to the Patient Search function to ensure that users can find a patient using any 

relevant name field. 
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Users can now search for patients from various parts of the application using their Preferred First Name, Middle 

Name and/or Alternate Last Name. Users can enter only a portion of the name to perform the search. 

Values can be separated by a comma: 

• Text before the first comma will be searched against Last Name and Alternate Last Name. 

• Text after the first comma will be searched against First Name, Middle Name, and Preferred First Name. 

• Text after the second comma will only be searched against the Middle Name. 

Three new columns can now be added to the search results grid in the F3 - Patient screen to enable users to 

view patients’ Preferred First Name, Middle Name, and Alternate Last Name. Search results can be sorted by 

any of these fields. 

 

[KRL-12476] ADT Wizard Module enhancements for PharmacyLink 

Feature 

The ADT Wizard module has been updated to support the new fields added to the Patient record, ensuring that 

patient information can be properly processed when receiving New or Update Patient requests from 

PharmacyLink. 

The ADT Wizard’s ‘Patient Selection Page’ displays patient information received from the network under the 

Incoming ADT Patient section, allowing users to compare it against local patient data under the Selected 

Patient section. This page has been updated as follows: 

• The Search function of the Selected Patient section has been updated to utilize the newly enhanced Patient 

search functionality, allowing users to search for patient records using any name field, including Preferred 

First Name, Middle Name and Alternate Last Name. 
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• The Middle Name field has been added to both sections to help ensure that users match the incoming patient 

to the appropriate local patient. 

• The Gender field has been renamed to ‘Sex’. 

 

The ‘Patient update page’ has also been updated. Changes have been made to the Incoming ADT Patient 

Details and Local Patient Details sections: 

• The Salutation field has been relocated. 

• Fields for Suffix, Middle Name, and Preferred First Name have been added. 

• The old Gender field has been renamed to ‘Sex’, and a new Gender field has been added. 

• Information has been grouped into meaningful sections. 

• Existing field validation has been maintained, and the arrow buttons functionality works as before. 
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[KRL-12566] Display basic patient information on the F11 - Drop-off screen 

Feature 

The Drop Off screen has been updated to support the new fields added to the Patient record, ensuring that 

patient information can be properly entered when processing a prescription. 

• The Patient Search field at the top of the screen has been updated to utilize the newly enhanced Patient 

Search functionality, allowing users to search for patient records using any name field, including Preferred 

First Name, Middle Name and Alternate Last Name. 

• The old Gender field has been renamed to ‘Sex’. 

• A new Pronouns field has been added. 

• The Age field has been moved under the DOB (Date of Birth) field. 
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• If the full name exceeds the size of the Patient Search box, hovering the mouse pointer over the box will 

display a bubble showing the full name. 

 

[KRL-12789] Ensure consistency of the new Sex and Gender fields across the application 

Feature 

For consistency, all previous instances of the Gender field throughout the application have been renamed to 

‘Sex’. The following elements have been changed (note that this list may not be exhaustive): 

• Reports, including their configuration options have been updated to support these changes. 

• Creatinine Clearance 

Report 

• Medication Review 

• Minor Ailment Review 

• Negative MAR 

• Patient Biometric Report 

• Patient Listing Report 

• Patient Mailing List Report 

• Patient Profile Report 

• Pharmacist Prescription 

Notification 

• Rx Adaptation Review 

• Rx Extension Review 

• Universal MAR 

• Universal TMR
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• Patient Plan Information form 
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• ADT Wizard 

• Patient update page 
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• Adjudication screens 

• CeRx and CPhA Claim and Response adjudication forms 
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• Network patient search screens 

 

• Labels 
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• Store Level Configuration Parameters and Head Office Level Configuration Parameters screens 

 

 

• Consent forms 
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• ERx Orders screens 

 

• Prompts 

 

• F12 - prescription-filling screen 

• Prescription warnings and messages 
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[KRL-13164] Confirmation dialog when modifying a patient name 

Feature 

Recent changes have been made to enhance the way users can modify a patient's name from the patient card. 

The patient name fields have been consolidated into a read-only field at the top of the patient card. Users can 

modify the names via a new Modify button, which opens the Patient Name window for editing. 

When users press the Enter key or click OK to save changes, if the First Name or Last Name has been altered, a 

confirmation dialog will appear. This dialog allows users to compare the new values against the original ones, 

providing an extra layer of validation. 

This safeguard has been implemented due to the significant implications of changing patient name information. 
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Payments 

[KRL-12312] Hide Credit Card on a Pre-Pay Account where there is an invalid PharmacyLink 

association 

Feature 

The AR Profile screen has been updated to further enhance patient safety and data privacy. The system now 

hides the Credit Card number if it is owned by another person and there is no valid link between the two parties.  

A link is deemed valid when the following conditions are met: 

• There is a PharmacyLink link between the two parties. 

• The link has not expired. 

• The Authorized Agent has the permission ‘Order or pickup Rxs’ assigned to them. 

 

Reports 

[KRL-9283] Improve the Drug Inventory History Report to track discarded medications 

Improvement 

When cancelling a prescription that has already been picked up by the patient, the user is presented with two 

options for processing the cancel: Cancel and Rebill or Cancel Rx. 

If the Cancel Rx option is selected, users are prompted to specify whether the medication should be discarded. 



Kroll V10 SP31 Feature Release Notes  61 

 

If the user selects Yes, indicating that the medication will be discarded, the dispensed quantity is not added back 

to the drug’s on-hand inventory. 

The Drug Inventory History Report has been enhanced to keep track of this occurrence. A new setting has 

been introduced under the Options tab of the report’s configuration screen: 

• Show Drug Packs That Had Inventory Discarded 
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When enabled, the report will display Drug Packs for which a quantity was dispensed and subsequently 

discarded, along with the prescription number, date and quantity of the discarded medication. 

 


